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General Navigation

In the following sections you will learn to…
1. Launch Hyperion Workspace
1. Set General and Explore preferences
1. Open Planning applications
1. Add favorites
1. Printing Reports 
[bookmark: _Toc394595980][bookmark: launchinghyperionworkspace]Launching Hyperion Workspace

To start Planning, you log on to Hyperion Workspace with your user name and password. 

1. Navigate to Hyperion Workspace: https://encore.ok.gov

2. Enter User Name and Password

3. Click “Log On”
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Opening Hyperion SOK PLAN

[image: ]

1. Click the Navigate menu.

2. Click the Applications menu.

3. Click the Planning menu.

4. Select SOKPLAN application
 
[bookmark: _Toc394595981]























Changing Password

1. Click the Tools menu.
 

[image: ]


2. Click the Change Password... menu.

3. Enter the desired information into the Current Password

4. Enter the desired information into the New Password

5. Enter the desired information into the Confirm Password

6. Click the Save button.









[bookmark: _Toc394595982]Setting Preferences and Favorites

The first time you log into Hyperion you will need to set your preferences.

Setting Preferences 

1. Open SOK PLAN 


[image: ]


2. Click the File menu.

 
[image: ]

3. Click the Preferences

4.  Click the Planning icon

5. Click on 4th tab called “User Variable Options” 


6. Set the Dimensions according to year you will need choose the (...) icon, to make changes

7. Click the Save Button


[bookmark: _Toc394595984]
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Adding Favorites

Favorites enable you to quickly access frequently used items and documents. 

[image: ]

1. Go to Explore Button

2. Click the +  sign by SOK PLAN 

[image: ]


3. Select folder or form to be placed in favorites ie. Capital Planning, Human Capital Planning. 

[image: ]


4. Click the Favorites menu.

5. Click the Add to Favorites list item.

[image: ]

[bookmark: _Toc394595986]***Notice that the folder is now listed as a favorite. ***You successfully added a folder to your favorites.
Hide View Pane and Content Area

For a maximum view of content area user can hide view pane

1. Click the Collapse Pane button.

[image: ]

2. The View pane is hidden and the content area page is expanded.












Reports
Navigation to Reports Folders 
To run reports, you will first need to navigate to the Explore workspace at the top-left of the screen:
[image: ]
Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally the Budget Request Reports folder:
[image: ]







Operational Planning Reports 
· Operational Planning - Provide or verify Agency Information
· Report Name: Agency-Organizational Information
· Operational Planning - Provide Agency Program Information
· Report Name: Program Information-Performance Measures
· Operational Planning - Identify Legislation Needs
· Report Name: Legislation Needs
· Operational Planning - Operational Decision Package
· Report Name: Decision Package Detail Report
This report is located in a different place than the other reports. Details are on Pg .8

Strategic Planning Reports 
· Strategic Planning - Provide Executive Summary
· Report Name: Strategic Plan Report
· Strategic Planning – Goal Setting 
· Report Name: Strategic Plan Report KPMs





























Reports
[bookmark: AgencyInformation]Operational Planning – Provide or verify Agency Information
Report Name: Agency-Organizational Information
To run this report, you will first need to navigate to the Explore workspace at the top-left of the screen:
[image: ]
Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally the Budget Request Reports folder:
[image: ]
Then double-click on the Agency-Organizational Information report to start it:
[image: ]
A new page will open with a prompt:
[image: ]
Make sure the ‘Edit Member Names’ checkbox is checked to allow for typing in the Selection field:
[image: ]
Then type in your agency number (use the full 5 digits):
[image: ]
Then hit the OK ([image: ])button to run the report. Once run, the report should come up within Hyperion:
[image: ]
To turn that report into a PDF file, click on the PDF icon ([image: ]) at the top-left of the screen:
[image: ]
The PDF file will open within Hyperion. You can then print it using the Print icon ([image: ]) at the top-right of the screen:
[image: ]
Or you can download it and save it using the Download button ([image: ]), also at the top-right of the screen.







[bookmark: AgencyProgramInformation]Operational Planning – Provide Agency Program Information
Report Name: Program Information-Performance Measures

To run this report, you will first need to navigate to the Explore workspace:
[image: ]
Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally the Budget Request Reports folder:
[image: ]
Then double-click on the Program Information-Performance Measures report to start it:
[image: ]
A new page will open with a prompt:
[image: ]
Make sure the ‘Edit Member Names’ checkbox is checked to allow for typing in the Selection field:
[image: ]
Then type in your agency number (use the full 5 digits):
[image: ]
Then hit the OK ([image: ]) button to run the report. Once run, the report should come up within Hyperion:
[image: ]
If information was entered at multiple levels (i.e. at the Department, Division, or Agency level), then that data can be viewed by selecting the appropriate entity from the dropdown box located in the middle of the report:
[image: ]
To turn that report into a PDF file, click on the PDF icon ([image: ]) at the top-left of the screen:
[image: ]
The PDF file will open within Hyperion. If information was entered at multiple levels, the PDF of the report should show all of them. The entity will be shown at the top left of the report. This example will be for the division level entity of 41500_10:
[image: ]
You can then print it using the Print icon ([image: ]) at the top-right of the screen:
[image: ]
Or you can download it and save it using the Download button ([image: ]), also at the top-right of the screen.
[bookmark: IdentifyLegislationNeeds]Operational Planning – Identify Legislation Needs
Report Name: Legislation Needs
To run this report, you will first need to navigate to the Explore workspace at the top-left of the screen:
[image: ]
Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally the Budget Request Reports folder:
[image: ]
Then double-click on the Legislation Needs report to start it:
[image: ]
A new page will open with a prompt:
[image: ]
Then type in your agency number (use the full 5 digits):
[image: ]
Then hit the OK ([image: ]) button to run the report. Once run, the report should come up within Hyperion:
[image: ]
If information was entered at multiple entities (i.e. at the Department 9000001, 9000002, etc), then that data can be viewed by selecting the appropriate entity from the dropdown box located in the middle of the report:
[image: ]
To turn that report into a PDF file, click on the PDF icon ([image: ]) at the top-left of the screen:
[image: ]
The PDF file will open within Hyperion. You can then print it using the Print icon ([image: ]) at the top-right of the screen:
[image: ]
Or you can download it and save it using the Download button ([image: ]), also at the top-right of the screen.

[bookmark: OperationalDecisionPackagesSummary]Operational Planning – Operational Decision Packages
Report Name: Decision Package Detail Report
To run this report, you will first need to go to the SOKPLAN application. You can do this by going to the Navigate menu at the top-left of the screen:
[image: ]
Once in the SOKPLAN application, you will need to go to the Tools menu at the top-left of the screen, then select the Reports option.
[image: ]
Once the Reports option is selected, a new screen should appear in Hyperion with a Decision Package tab: 
[image: ]
In order to run the reports, you will first need to select the appropriate point-of-view (POV):
[image: ]
For the FY16 Budget Requests, here are the selections you will need to make:
[image: ]
Then load the POV by selecting the Go button ([image: ]). Once loaded, the Available Decision Packages portion of the screen should populate with the decision packages your agency has created:
[image: ]
Select the package you wish to run the report for by checking the checkbox next to it:
[image: ]
Then move it over to the Selected Decision Packages portion by hitting the Move button ([image: ]):
[image: ]
Once it is selected, choose the Detail report option from the dropdown list on the Decision Package Listing: 
[image: ]
Then proceed to click the Create Report ([image: ]) button listed at the bottom-right hand of the screen. Doing so will prompt you with a window asking if you would like to save the report, or open it as a PDF:
[image: ]
If you have Adobe Reader, it should then open a window with your Decision Package Detailed report:
[image: ]
[bookmark: StrategicPlanExecutiveSummary]
















Strategic Planning – Provide Executive Summary 
Report Name: Strategic Plan Report
To run this report, you will first need to navigate to the Explore workspace at the top-left of the screen:
[image: ]
Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally the Budget Request Reports folder:
[image: ]
Then double-click on the Strategic Plan report to start it:
[image: ]
A new page will open with a prompt:
[image: ]
Then type in your agency number (use the full 5 digits):
[image: ]
Then hit the OK ([image: ]) button to run the report. Once run, the report should come up within Hyperion:
[image: ]
This report will pull data entered in other portions of Hyperion, including the Provide or verify Agency Information task. To turn that report into a PDF file, click on the PDF icon ([image: ]) at the top-left of the screen:
[image: ]
The PDF file will open within Hyperion. You can then print it using the Print icon ([image: ]) at the top-right of the screen:
[image: ]
Or you can download it and save it using the Download button ([image: ]), also at the top-right of the screen.









[bookmark: StrategicPlanGoalSetting]Strategic Planning – Goal Setting 
Report Name: Strategic Plan Report KPMs
To run this report, you will first need to navigate to the Explore workspace at the top-left of the screen:
[image: ]
Once in the Explore workspace, go to the SOKPLAN folder, then the Line Item folder, and finally the Budget Request Reports folder:
[image: ]
Then double-click on the Strategic Plan Report KPMs to start it:
[image: ]
A new page will open with a prompt:
[image: ]
Then type in your agency number (use the full 5 digits):
[image: ]
Then hit the OK ([image: ]) button to run the report. Once run, the report should come up within Hyperion:
[image: ]
To turn that report into a PDF file, click on the PDF icon ([image: ]) at the top-left of the screen:
[image: ]
The PDF file will open within Hyperion. You can then print it using the Print icon ([image: ]) at the top-right of the screen:
[image: ]
Or you can download it and save it using the Download button ([image: ]), also at the top-right of the screen.















[bookmark: InternetExplorer]Additional Navigation Tools
Printing and Saving Reports with Internet Explorer

There are some slight discrepancies when using Mozilla Firefox and Internet Explorer. When trying to save a PDF in Internet Explorer, you can simply go to the Internet Explorer File menu and select Save as…:
[image: ]
However, in order to directly print a PDF straight from Hyperion, you will need to hover your mouse cursor over the PDF so that the following menu appears on the PDF:
[image: ]
The Save button ([image: ]) will also allow for the saving of the reports, and the Print button ([image: ]) will let you print the report directly from Hyperion.















Importing Documents 

To Import a file, you will first need to navigate to the Explore workspace by clicking on the Explore button at the top-left of the screen:
[image: ]

Navigate to your agency’s Budget Supporting Documents folder and double click.
[image: ]

Right click on your agency’s folder or in the white-space on the right side of the screen, and Import a File:
[image: cid:image003.png@01CFD729.2AAC7550]


Choose the file you wish to import by Browsing ( [image: ]) to the location of the file on your computer:
[image: cid:image004.png@01CFD729.2AAC7550]

Be sure to hit the Next button and not the Finish button:
[image: cid:image005.png@01CFD729.2AAC7550]

You don’t have to adjust any of the Advanced option if you don’t want to, so hit the Next button again. 

On the Permissions screen, you will choose who can access, view, or modify the attachment. This is done by assigning access to individual users, user groups, or user roles to the document. The easiest might be to assign access to groups.

You will first need to search for the groups by clicking on the Groups tab:

[image: ]

Then go to the bottom and change the search feature from “begin with” to “contain”:
[image: ]

Then type in your agency number to find your agency’s groups, or “all” to find the All Agency groups. For example:
[image: cid:image006.png@01CFD729.7DF31F70][image: cid:image007.png@01CFD729.7DF31F70]


LI is for the Operational Planning & Strategic Planning modules, HCP is for the Position Budget module, and Capital is for the Capital Budget module.

All Agencies groups are your OMES Budget and Capital analysts. Agencies also have their own module groups.

Then select the group and add them to the allowed groups:
[image: ]

In order for users of those groups to view or access the attachment, they will need to be given access to it. To assign that access, you will need to click in the Access column on the screen: 

[image: cid:image008.png@01CFD729.B8CFC990]

Once that is done, then you can apply these default permissions to any file you import, if you want to:
[image: cid:image009.png@01CFD729.B8CFC990]

Once Imported into Hyperion, and then right click on the cell you wish to attach the file to and choose the Document Attachments option:
[image: cid:image010.png@01CFD72A.4A1B38D0]

Hit the Plus sign to add a new attachment, either by using the shortcut or by selecting that option from the Action menu:
[image: ]

Type in a description for the attachment, and then select the Browse to Workspace button underneath the Reference box:
[image: cid:image012.png@01CFD72A.4A1B38D0]

Search for your agency’s Budget Supporting Documents folder, and select the imported file you wish to attach. Then hit the OK button.

After that, the file has been attached to that particular cell and should be noted by a green tab type object in the upper right-hand side of the cell (similar to Excel signifying a comment with a red tab type object on a cell). However, it might still be wise to make a note in the cell that there is an attached document, just in case the reviewer’s eyes miss the little green tab type object.













[bookmark: _Toc394595989]
Adding Comments
Comments are a useful feature for identity data that is entered in fields. 

1. Click the Navigate menu.
2. Click the Applications menu.
3. Click the Planning menu.
4. Click the SOKPLAN menu.
5. Go to My Task List.
6. Click any  task list form ie. Operational Planning-Plan Agency Revenue to add comments.
7. Right-click the any cell where the comment is to be inserted.
8. Choose “Comments”

[image: ]

9. Click Action drop down button, then Add button  OR click +  

 [image: ]

10. Enter the desired information into the Comment field. 

11. Click the Add button.

[image: ]

12. Click the Close button.

13. Green Indicator in top right corner of cell lets user know there is a comment for that cell.
 



Copy/ Paste Option

To copy from an external document.  ie. Word and paste into cells in Hyperion. 
Select Ctrl + C: this copies the selected range of cells to the clipboard then Select Ctrl + V: Pastes content from Clipboard into cells in Hyperion.
























Complete Button

For each listed task in the side menu users have the ability to keep track of their progress as they move through each budget process. These buttons also help users to advance to the next task, go to previous task, go to previous or next incomplete tasks and navigate back to the Task List Home page. 
**This complete box is NOT a required option. It is intended for the user to keep track of their progress.


[image: ]

On the task list home page, once a user checks the complete button Hyperion will keep track which tasks have been complete with a pie chart, indicating Incomplete, Complete and for items that have dues dates and Overdue status color. 

[image: ]
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